
  

 

IPv6 is Coming 
by Cal Esneault, President and leader of many Open Source Work-
shops & SIGs, Cajun Clickers Computer Club, Louisiana  
     Canonical (Ubuntu Linux) and Google recently announced they 
would participate in a 24-hour trial of IPv6 on June 8, 2011, along 
with Facebook, Yahoo, and others. This means that some of the big 
names in open source software will be involved with the new Inter-
net Protocol, version 6 (IPv6) which will be needed to replace the 

current Internet Protocol, version 4 (IPv4).     To get to an Internet 
address, we usually type in a name, such as Clickers.org or 
Google.com. Software then goes to a distributed database from a 
Domain Name Server (DNS) and uses a table to translate this into a 
32-bit numerical identifier. The identifiers are split into four 8bit 
segments. Since 8 binary digits (bits) can span the range from 0 – 
255, we sometimes see these addresses as the decimal equivalents 
separated by periods. For example, 192.168.1.2 is a typical address 
for our internal networks when using routers. If we use the last 
“block” (last 8 bits), we could theoretically have 256 computers in 
this network. The total number of distinct addresses in IPv4 is 256 x 
256 x 256 x256 = 4.3 billion. When the Internet first started, no one 
could conceive that more than 4 billion addresses would be needed, 
but the need for each home network and each mobile phone to 
have an address is straining that concept. Recently, the last big 
“blocks” were issued to area centers for distribution.  

     The problem is not as bleak as it may seem since many addresses 
can be issued temporarily, some early users took more than they 
really need and can give some back, and only one address is needed 
for a private network which handles many computers within its 
structure. Some believe that we will run out of freely available ad-
dresses by the end of 2011, and that new addresses will have to wait 
for an old one to be freed up. 

     Internet designers have been working on the new IPv6 protocol 
to solve issues with the old system. It will have 128-bit addresses 
which will provide for a possible of 340 trillion, trillion, trillion ad-
dresses (3.4 x 10^38). This at first seems silly today since each per-
son on earth could have trillions of addresses, but it becomes more 
reasonable when you realize that any electronic device in your home 
(which will soon be a computer) and any device in a factory or auto-

mobile could have a unique address for control purposes. Also, it is 
hoped this will be sufficient for a very long time so that the change 
will be permanent in even our grandchildren's lifetimes. 

     The addresses for IPv6 will be split into eight 16-bit units. Since 
the decimal number for each unit is large (2^16 = 65,536), the ad-
dresses will be in hexadecimal notation (a = 10, b = 11, … , f=15). 
An example address might look like fe80:0:0::200:f8ff:fe21:67cf 
where fields are separated by a colon, leading zero's can be omitted, 
and blank fields can be represented by multiple colon marks. There 
will be a protocol which allows current IPv4 addresses to be con-
tained within the new IPv6 address. If all works as hoped, we won't 
care since our DNS resources will fill in numbers for us when we 
type in Clickers.org, etc., just like it happens today. 
     Modern operating systems (Windows, Mac OS, Linux, BSD) 
have already been  configured to allow for IPv6 protocol. 

 Your current router and your ISP (Internet Ser-
vice Provider) equipment may not be ready.  
     In complex computer networks, all of the interactions between 
equipment and older software are not sufficiently known. Therefore, 
the test on June 8 will be the first of probably many to debug the 
issues which will have to be addressed.  
     A similar situation was envisioned when we moved into the 21st 
century (known as the Y2K issue, where ambiguity between dates 
could occur since early software only used the last two numbers for 
years). 
     In that case, the situation was handled well and none of the dire 
predictions about airplane crashes and business shutdown came to 
pass. It did, however, take a lot of work and effort to prevent chaos. 
Will IPv6 be a big event, or just a problem for com-
puter professionals? We don't  know yet, but open source 
folks are in there with everyone else to help. II 
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Linux Software of  the Month 
by Geof Goodrum, President, Washington Area Computer User Group, VA 
     The software described below can be downloaded at the links provided or copied onto a 
USB flash drive at the WAC meeting. However, please check the online package management 
tool included with your GNU/Linux distribution first, as installation is often just a click 
away. 

Free Pascal – v2.4.2. http://www.freepascal.org/. Modified GNU Li-
brary General Public License source code and packages for Debian and 
RPM-based GNU/Linux distributions by the Free Pascal Development 
Team. Originally named FPK-Pascal, Free Pascal is a 32 and 64 bit Turbo 

Pascal and Delphi compatible Pascal programming language compiler for DOS, Linux, 
Win32, OS/2, FreeBSD, AmigaOS, Mac OS X, Mac OS classic and several other platforms 
(the number of supported targets grows all the time, although not all of them are on the same 
level as the main ones). The Free Pascal compiler is available for several architectures, x86, 
Sparc (v8,v9), ARM, x86_64 (AMD64/Opteron) and Powerpc. An older version (the 1.0 
series) also supports m68k.      The compiler is itself written in Pascal and is able to compile 

its own sources. 

Hedgewars – v0.9.15. http://www.hedgewars.org/. Free GNU 
General Public License source code and executable packages for Debian, Ubuntu, Fedora, 
ArchLinux, and openSuSE Linux by Andrey Korotaev et al. Hedgewars is a turn-based strat-
egy, artillery, action and comedy game, featuring the antics of pink hedgehogs with attitude as 
they battle from the depths of hell to the depths of space. As commander, it’s your job to 
assemble your crack team of hedgehog soldiers and bring the war to your enemy.  
     Features: Hilarious and devastating turn based combat for up to 6 players; Both local and 
network multiplayer, with optional AI opponents; Battle on an infinite number of randomly 
generated maps, with over 20 environments; Utilize 47 (and counting) devastating weapons 
including the piano strike and explosive robotic cake; Play the game your way, with 18 differ-
ent game modifiers, tweak almost every aspect of the match; Customize your team, with over 
120 costumes, 30 graves, 12 forts, 100s of flags and unique voice packs; Huge battles with up 
to 48 hogs; Play both singleplayer and multiplayer minigames; plugin your own custom maps, 
costumes, and other artwork.  
Requires Qt >= 4.5, FreePascal >= 2.2.4, SDL >= 1.2.5, SDL_net >= 1.2.5, SDL_mixer >= 
1.2, SDL_image >= 1.2, SDL_ttf >= 2.0, CMake >= 2.6.0, lua = 5.1. 

Linphone – v3.4.3. http://www.linphone.org/. Free GNU General Pub-
lic License source code and executable packages for Debian and Ubuntu 
Linux by Simon Morlat. Linphone is an audio and video Internet phone 

with GTK+ and console interfaces. It uses the Session Initiation Protocol (SIP), and is com-
patible with most SIP clients and gateways.  
     It can use various audio and video codecs such as Speex, GSM, G711, ilbc, amr, Theora, 
H263-1998, MPEG4, H264, and snow. This version improves Mac OS X integration with 
desktop menus, better sound system handling, and binary bundle generation for ease of in-
stallation. It also improves memory usage and fixes a few SIP bugs. 

WordPress – v3.1. http://wordpress.org/. Free GNU General Public License 
scripts by the WordPress Development Team. WordPress is a software script 
that, together with PHP v4.3 or greater, MySQL v4.1.2 or greater, and a web 

server (e.g. Apache; Nginx), provides a point and click menu-driven framework for a stan-
dards-compliant, professional looking web site that is easy to maintain with no knowledge of 
web programming required. WordPress is the most widely used framework for self-hosted 
blogging web sites, and is highly customizable with thousands of widgets, themes and plug-
ins, both free and commercial. New features include the admin bar, which provides easy ac-
cess to common administrative tasks from the front-end for logged in users; internal linking, 
which lets you easily search for and link to existing content within your site from within the 
WYSIWYG editor; a standard set of post formats, enabling the creation of tumblelog-type 
sites; archive pages for custom post types; advanced taxonomy; and custom field queries.  
Kernel Source - v2.6.38. http://www.kernel.org/. Free GNU Public License source code for 
all platforms by the Linux community. II 
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   What Exactly 
is an Intranet? 

by Gordon Giles, Committee 
Member, Perth PC Users Group 
Inc., Australia  

     1. The best way to de-
scribe an intranet is for you to 
think of the last time you 

went to a large company to get informa-
tion or pay a bill no matter which teller 
you go to they have your data on the 

screen in front of them. Their main com-
puter holds an internal network system 
and only people in that building with the 
correct password have access to your 
information sometimes it is used by other 
offices in other buildings and even over 
the whole world. When they start their 
computer it automatically starts their 
intranet and after entering a password 
they have access to the main computer to 
carry out the work. The intranet you will 
be using on your computer will be for 
your use only so you will not have a pass-
word and it will only start when you open 
Internet explorer or your chosen 
browser. You don’t need HTML 
or a WISIGIG type program to 
compile your intranet page we 
will be using MS Word 2011 or 
you can use an earlier version. 
Your page can contain links to other web 
sites, files on your computer and emails.  
     2. Make a new folder in my docu-
ments call it “My Intranet”. Now think of 
a web page would you like a picture in the 
background or maybe use some favourite 
icons for shortcuts make copies of them 

and save them in your new folder. This is 
important you may have seen web pages 
with a box and a small red cross in the top 
left corner this is a website where the pic-
ture for that area is missing. 
     3. Start MS Word. Before we go any 
further we are going to save this page as  
an HTML file or HTM. 
     4. Click on file and save as in the top 
left of the screen change the area  to save 
in to the new file in My Documents/My 
Intranet. 
      5. Change the name to “index” and 
change the Save as type to Web Page  
HTM. HTML. Then save your first web 
page. Now you have the page created from 
time to time you need to save  your work 
just hold down the CTRL key and press 
the S key this will save the changes. 
     6. Using the usual features in MS Word 
give your page a name. 
     7. You can use a table to arrange your 
links or just one line after another  it will 
look more professional if you use tables.  
(Click on insert to see the table icon). 
     8. In each of the boxes place the name 
of a link or place one of the small icons 
you saved using insert to place the icon in 
the box.  Remember to save. 
     9. The first link we will attempt is the 
email link one you may use frequently. 
Highlight your new email link click on 
insert and select Hyperlink when the new 
box opens the highlighted word you se-
lected should be at the top then in the 
bottom empty box labelled Address type 
mailto; then the email address you wish 
the email to go to. 
     10. Click ok and save. Minimise MS 
Word go to your new folder and click and 
run the index.htm file when it opens click 
on the new email link and your chosen 
email program will open with a blank ad-
dressed email ready to be completed this is 
just to prove it works. Close the email, 
don’t save. And reopen your web page in 
MS Word. 
     11. Next we will insert a link to a web 
page. Open windows internet explorer and 
select a web page you look at regularly I 
will be using the group’s web page. 

Copy the URL in the address bar at the top 
of IE. Then reopen your index.html  
page in MS Word 
     12. Highlight the text you entered for 
this sight or type in the name not  the ad-
dress then select insert and select hyperlink 
and past the URL  you copied earlier in to 
the area marked address. 
     13. Now save your work you can test 
this file in MS Word hold down the CTRL 
key and use the mouse pointer to click on a 
link. Remember to close IE before continu-
ing. 
     14. If you wish to use an icon in place 
of text for the link just insert the icon in 
the page and instead of highlighting the 
text and making a hyperlink just highlight 
the icon. Now for some background this is 
best done last as it can make it difficult to 
see the area you need on the page. 
     15. In MS Word select Page Layout 
then page colour select the colour and then 
save. This is just a plain background if you 
wish a picture to appear as a background it 
is difficult in word to get it to stretch and 
cover the screen and the only way I have 
found to do this is to use an HTML editor 
but it’s a good exercise let me know if you 
have found a way of getting a full edge to 
edge background. 
     16. One last link it’s not a usual link but 
you may have a file you like to work on like 
a diary each day and you can add a link for 
this. Place the required text on your web 
page then highlight the text select insert 
then select hyperlink when the new win-
dow opens you have to locate the file on 
your computer use the small manila folder 
icon to go back to a previous folder. Click 
on the file you wish to run and that’s it 
now save it. 
     17. Do all your tweaking and alterations 
and save it test your new index.html file 
and if it all works get it opened in IE and 
select tools/internet options and with your 
new inde.html page in IE in the back-
ground select use current apply and ok. 
each time you open IE you will have your 
own personal internet web page that no 
other person can see. ll 
 

Question: How deep is the  Mariana Trench  in round figures. 

A. 25, 000 ft 
B. 30,000 ft 
C. 35,000 ft 
D. None of  the above 

 Question: Name the figure on the left; 
A. G-man 

B. Mapman 

C. Pegman 

D. None of the above. 
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CONVERTING 
DOCUMENTS 
TO PDF 

by Wayne Comstock, Member 
South Walton Computer & 
Technology Club, Florida 

      One technique I frequently use to save 
an online article or publication is to convert 
and save it as a PDF file. Once converted, 
Adobe Reader software then becomes an 
excellent way to open, view and read any 
converted document off of your computer 
screen. Pdf documents can also be easily 
emailed to others as an attachment.  

any file you can print, including Microsoft 
Word, Works, Excel, PowerPoint and digi-
tal pictures. Rather than being printed ink 
to paper the file becomes a PDF file. If the 
document is already a paged PDF file you 
can convert the file to just the pages you 
select and select your PrimoPDF printer to 
convert. 
     You will need PDF conversion software 

to accomplish this. I recommend the Free 
PrimoPDF program. It's free, easily in-
s t a l l e d  a n d  a v a i l a b l e  a t :   
www.primopdf.com/index.aspx      

Downloaded 15,000,000+ times.  
PrimoPDF is the world’s most popular free PDF creator. 

    1. Browse Primo web site and download 
one of the two installers available for 32 
and 64-bit versions of Windows. Ensure 
that the version you download corresponds 
to your operating-system. 
     2. When prompted, select a download 
location which you can find easily, such as 
your ‘Desktop’ or ‘My Documents’ folder, 
and click OK. 
     3. When the download is complete, 
double-click the file named FreewarePri-
moPDFXX.exe (XX being a 2-digit num-
ber) which would have appeared in the 
location you selected in the previous step. 
     4. Follow the simple instructions to 
complete the installation. A system-restart 
is NOT required. 
     PrimoPDF installs itself as a virtual 
printer in the Windows Printers and Faxes 
device group. This allows any software with 
print functionality to output files to Pri-
moPDF for quick and easy PDF conver-
sion. 

To Convert a Document to PDF: 
     1. Open a document in any printable 
program (e.g. Microsoft Word, Works etc.), 
and select File >Print. 
     2. In the printer dialog, select Pri-
moPDF from the dropdown menu and 
click OK to complete the print, and launch 

the PrimoPDF interface. 
     3. Select one of the Creation Profiles for 
the document Quality you need to achieve. 
A detailed explanation can be found in the 
PDF Creation profiles section of this guide. 
Point your cursor at each button to define. 
 
 
 
 
 
     4. Select the Save As dropdown menu 
to set a name and location for the created 
PDF. 
• Ask when creating PDF – Allows you to 
rename the PDF and select a save-location. 
• Specific Folder – Allows you to select a 
save-location while using the name of the 
document which is being converted. This 
option returns you to the PrimoPDF inter-
face should you wish to change other set-
tings for the same conversion. 
     5. Click the Create PDF button to con-
vert your document. 
      6. Alternatively, if you wish to save the 
PDF under a different name of directory, 
just click Cancel and you will be returned 
to the Save As dialog. There are many 
more options and features available. 
(Appending a PDF) Go to the web site 
below and download the PDF Pimeo de-
t a i l e d  U s e r  G u i d e . 
http://www.primopdf.com/pdfs/PrimoP
DF_V5_User_Guide.pdf ll 
 
 

You can convert to PDF from 

 
Easily view, print, and collaborate on PDF  

files with free Adobe Reader X software     
     Adobe Reader software is the global standard for elec-
tronic document sharing. It is the only PDF file viewer that 
can open and interact with all PDF documents. Use Adobe 
Reader to view, search, digitally sign, verify, print, and col-
laborate on Adobe PDF files.   

 Free download 
http://www.adobe.com/products/reader.html 

      A free online computer dictionary and internet search 
engine for internet terms and technical support.   
     Stay up to date on the latest developments in internet ter-
minology with a free weekly newsletter from Webopedia. Join 

     The most comprehensive source for 
free-to-try software downloads on the 
web. Find the software you're looking for 
at CNET .com,  

 http://download.cnet.com  
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Cloud Computing 
by Dick Maybach, n2nd (at) charter.net 

     Although you can hardly pick up a computer publication with-
out being assaulted by references to cloud computing, the term has 
been abducted by marketing organizations to the extent that it 
means almost nothing. Today, “cloud” is to computing as “natural” 
is to food. Although the term means little, the concept is very valu-
able, and is something that most computer owners use every day. 
 Cloud computing is using storage or processing resources on the Internet.  
Most of us already use cloud computing far more than we realize; 
for example, every e-mail we receive sits on our ISP's disk until we 
download it to our PCs, and when we use Google Maps, much the 
processing and all of the storage occurs on Google's hardware. In 
the extreme, cloud computing could evolve to the point where our 
computer would consist of only a keyboard, mouse, display, and 
perhaps a printer, with just enough processing power and software 
to support a Web browser. Google foresaw this as the future of 
home computing and began developing their Chrome operating 
system to support it. 
      A simple example of cloud computing is a backup service, 
which continually backs up all your data whenever you are con-
nected to the Internet. You don't have to think about it, and be-
cause your backups are stored at a different location, they are safe 
even in case of a local catastrophe. A similar use is synchronizing 
data among several computers, where the data might be files, con-
tacts, and your favorite Web sites and (with care) their passwords. 
Many people also use the cloud to share information with others, 
for example by using Facebook for personal information, Flicker 
for photos, or Google Docs for documents. Cloud storage is both 
convenient and inexpensive; indeed, many vendors offer up to two 
gigabytes free. 
     All the above examples are data storage ones, but there are also 
cloud processing services, such as Google Docs. Google Docs sup-
ports the common office tasks such as word processing, spread-
sheets, and presentations, which means you can perform these with-
out purchasing an office suite and having to keep it updated. It also 
allows on-line collaboration (where, for example, several people edit 
the same document), although few home users are likely to need 
this feature. Like cloud storage, cloud processing is inexpensive or 
even free. 
     By now, you may be thinking, “What's the Catch?” Somebody 
has to pay for these services, as providing them requires non-trivial 
costs for computer hardware, support staff, and communications. 
In some cases, the free service is a limited sample to entice you to 
purchase a more versatile one. In others, you are the product being 

sold. Your habits and preferences are valuable commodities that 
advertisers will pay to learn about. For many of us this is a fair 
trade; in return for the convenience of Google's search engine, we 
tolerate the ads in the sidebar and being directed to sites that want 
to sell to us. 
     However, there are some security and safety caveats involved. 
Security is complex for a cloud vendor; your data are stored on the 
same disks, the same memory, and pass through the same proces-
sors as everybody else's. The process is much like what happens in a 
commercial laundry or dry cleaner, where everybody's clothes are 
tagged and thrown together into a large machine. Afterwards, some-
body looks at the tags to get them back to their proper owners. 
Contrast this to a bank deposit vault, where only your key can open 
the box where you place your documents. Even at such competent 
vendors as Google, there have been instances of data leaking from 
one customer to another, and many cloud vendors are start-ups 
who have much less expertise than Google. This means that you 
should take responsibility for safeguarding your data. For example, 
if you back up your disk in the cloud, encrypt any files (such as 
those containing passwords or on-line banking data) that present 
security risks.  

     I store my passwords using KeePassX, 
http://www.keepassx.org/. Its file is always encrypted 
on your PC's disk, and you can safely back it up any-
where.  

     I also use Gnu Privacy Guard (gpg), 
http://www.gnupg.org/, to encrypt files and e-
mail.  

     (Both of these programs are available for the Windows, Mac, 
and Linux platforms.) By the way, when you encrypt a file, be sure 
that only the encrypted version is ever placed in a directory that is 
backed up in the cloud. 
     Safety also is not trivial. Vendors do go out of business and, 
even if they keep operating, they may find that providing cloud 
services isn't profitable. Not all of them back up their storage, 
which means that their hardware failures and software bugs can 
destroy your data. If you use the service for back-up or synchroni-
zation, this isn't a problem because the chances of simultaneous 
failures in the cloud and on your PC is negligible. However, if you 
store your only copy of your photograph or music collection in the 
cloud, you are risking disaster. In the case of cloud processing, you 
should also be concerned about the format in which your data is 
stored. It does little good to download the file containing your 
novel if it's stored in a format that only the (now out of business 
cloud vendor) could read. me glitches.  
      Finally, cloud computing is new, so you should expect some 
glitches. ll 

 

Adobe Cloud 
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Disk Maintenance 
by Les Townsing, Editor Melbourne PCUG, Australia 
     Cleaning up your hard drive can restore your PC’s Perform-
ance. There are three important utilities provided in Windows that 
help to improve a PC’s performance: 

1.  Disk Clean Up 
2.  Error Checking (previously known as Check Disk or Scan Disk) 
3.  Disk Defragmenter 

                              1. Disk Clean Up 
     Over time, unnecessary data and “leftover files” gradually col-
lect in all PCs as you use them. As this garbage collects it slowly 
clogs up your system, taking up space and making performance 
slower and slower. The Disk Cleanup tool helps you free up space 
on your hard disk by searching for files that you can safely delete. 
There are a number of ways to start Disk Clean Up. My preference 
is:  
• Open ‘Windows Explorer’ and right click on the required 

drive. 
• Select ‘Properties,’ click the ‘General’ tab, and then click ‘Disk 

Cleanup’ 
• Disk Clean Up will then scan the drive and provide you with a 

list of possible actions and an estimate of the space that can be 
saved 

       Depending on your system, a number of different file types 
are analyzed when the initial 
disk scan is conducted. After 
the analysis completes you 
can choose what to do with 
them. The analyzed files in-
clude: 
    In addition to the Disk 
Cleanup tab, the More Options 

tab offers further opportunities for freeing up hard drive space. 
There is nothing on this tab that isn’t available elsewhere within 
Windows in standalone fashion and some will be dealt with below. 

     There may be other categories that appear in your Disk 
Cleanup window, but in all cases, highlighting the item will display 
an explanation of the category in the Description area. 

2. Error Checking 
     Previously called Scan Disk or Check Disk, this utility is known 
as Error Checking within the Windows XP / Vista / 7 system. Error 
Checking will check the hard disk for defects in its platters. It will 
also check file systems. If errors are found it will attempt to fix 
them. These errors are found inside your hard drive may be caused 
for a number of reasons. These include: system crashes, applica-
tions that have been improperly closed and the existence of harm-
ful programs such as viruses 
     It is important to know that Error Checking is not a data 
recovery tool. Its job is to maintain the file system, and if your di-

rectories or files get in the way of this objective, they will be sacri-
ficed!  Before checking volumes or drives for errors, make sure 
that all other programs are closed, and disable your screen saver. 

To run Error Checking: 
1.  Open ‘Windows Explorer’ and right click on the required drive 
2.  Select ‘Properties,’ click the ‘Tools’ tab, and then click ‘Check 
Now’  You will be given the options of automatically fixing file 

system errors and recovering 
bad sectors 
Note: Vista and Windows 7 will 
not allow Error Checking to run 
while the system is operating. It 
must be scheduled to run at boot 
time. 

 
3. Disk Defragmentation 

     When files are created, deleted or modified it’s almost a cer-
tainty they will become fragmented. Fragmented means the file is 
not stored in one place in its entirety and different parts of the file 
are scattered across the hard disk. 
     Fragmentation causes the drive heads to search for all the 

pieces of a file in different lo-
cations. The more fragmented 
files there are on a drive, the 
more performance and reliabil-
ity suffer. 
     The Disk Defragmenter 
Utility is designed to reorganize 
fragmented files and optimize 
their placement on the hard 
drive for increased reliability 
and performance.  
15% Free Hard Drive Space? 
To run Disk Defragmenter: 

     Open ‘Windows Explorer’ and right click on the required drive 
Select ‘Properties,’ click the ‘Tools’ tab, and then click ‘Defragment 
Now’ 
     When Disk Defragmenter first opens you’ll see a list of the 
hard drives displayed at the top of the screen. Clicking on the 
‘Analyse’ button will display a graphical representation of the 
amount of defragmentation on the selected drive. 
     When the Defragment button is clicked, a graphical representa-
tion of the defragmentation during and after defragmentation is 
progressively shown. This graphical representation does not ap-
pear in Vista or Windows 7. You can schedule the Disk Defrag-
mentation Utility to automatically run at a pre-determined time in 
both Vista and Windows 7. 
     For the technically minded, you are also given the opportunity 
to view a defragmentation report after the drive is analyzed and 
when it has been defragmented. 
     For the majority of users, the Disk Defragmentation Utility 
included with Windows is sufficient to keep the hard drives in 
relatively good condition. If you are the type that wants to extract 
the best possible performance from a system, consider upgrading 
to one of the premium defragmenter products. ll 
 

• Downloaded program files • Setup Log files 

• Temporary Internet files • Backup files for a previous oper-
ating system 

• Recycle Bin • Offline files 

• Temporary Remote Desktop files • Compressed old files 
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The Mac Corner 
Backing Up Your Photos with iPhoto 
by Danny Uff, a member of the Help Line, Mac OS X and Win-
dows XP, Tiger/Leopard/Networking, Lehigh Valley Computer 
Group, PA 
     Digital photos are great. They allow us to save those memories 
onto our computers. Gone are the days of boxes and boxes of old, 
aged photos in some drawer (yes, I am old enough to remember 
them) or bent photo corners. Yep, it’s great!  Until your computer 
crashes, and you have no DVD or printed back up of those memo-
ries. Do you wish you knew a way to back up those photos that you 
spent hours importing into iLife’s iPhoto application?  Well, it’s 
easier than you think! 

 
 
 
 
 
      

     First you’ll need an external back up source. If you only have a 
couple photos, then a USB flash drive should do nicely. But if 
you’re like me, you have thousands of photos (old and new) so you 
may need to save them to a CD, DVD, external hard drive or an 
Internet back up service. Secondly, there are two ways to back up 
your photos using iPhoto: 
1.  If you do not have them sorted into groups, events, etc., just 

highlight all the photos, and then use the File> Export com-
mand 

2.  If you do have them sorted, then your best bet is to save the 
actual data file that iPhoto uses 

Backing this up is a snap: 
•   Open Finder, then select the Pictures folder 
•   Within that folder is a file called iPhoto Library. Make sure this 

file is saved to the external source you are backing up too. 
That’s all there is too it! 

     Now, to restore the photos, just get the external source and copy 
the iPhoto Library file back to the Pictures folder, then go back into 
iPhoto and bingo!   All of your events, places, faces and photos are 
back again. 
Printing from an iPad 
     By now, you may have seen the jazzy iPad TV Commercial that 
shows the device printing its output to an HP printer. Some Mac 
users have asked me if this was a real feature of the iPhone, iPod 
Touch and iPad?  The answer to that question is, yes and no. 
     YES - It is a real feature for the said devices and by having the 
current update to its operating system. If someone does have an 
Airprint-compatible printer it does work like a charm. NO - It does 
not work if you do not have an Airprint-compatible printer. 
      What is Airprint anyway?  It is a new printer protocol, devel-
oped by Hewlett Packard, that allows a user to print from a device 
such as a cell phone, to a compatible printer. If the user is on the 

same WiFi network as the printer, then the user’s device can pick 
the printer “out of the air” and send it to the printer. However, if 
the person is not on the same network, he or she can still  print to 
that printer by sending the document (or whatever else you’re print-
ing) to a special e-mail address for that printer. The user sets all this 
up when they first set up the device. 
     Hewlett Packard is the only company making such printers and 
they can range from $100.00 on up. They can be found at major 
retail and online stores. 
In-app Purchases 
     Back in mid December, there were a slew of reports on parents 
letting their kids play with their iPhone, iPod Touch or iPad getting 
billed for what is known as in-app purchases. 
     In-app purchases let a user purchase items within an iOS appli-
cation (such as more levels to a game, expanding an already pur-
chased app, etc.) using the user’s iTunes Credit Card or Checking 
Account. 
     One mother in the United Kingdom discovered that her 4 year 
old child spent more than $80.00 (U.S. Dollars) on in-app purchases 
- story via CNN. 
     Fortunately, there is a way to disable this feature so that little 
kiddies (or even you) don’t accidentally purchase something while 
in an application. 
1. Tap SETTINGS 
2. Tap GENERAL 
3. Tap RESTRICTIONS 
4. Enter a Restrictions pass code 
5. Select "Enable" 
6. Scroll down to "In-App Purchases" and make sure it is set to 
"OFF" 
7. Exit Settings 
     Personally, I have to say that with all of the experience I have 
with computers, I almost made a mistake with the above and have 
disabled this feature on my devices. ll 
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by Merle Nicholson, Secretary, Tampa PC Users Group, Inc., FL 
     I’ve modified and programmed keyboards, trying my best to 
optimize my time at the computer. Not that I don’t enjoy my com-
puter and the things I can accomplish, but, First, I’m a lousy typist, 
despite having practiced continuously since 1976, and, second, I 
hate messing with things that are obviously flawed. Keyboards are 
all flawed, that’s a given. Here’s how I’m coping. 
     I pretty much settled, a couple of years ago, on a Logitech Gam-
ing Keyboard model G11. It’s been succeeded by a model G510 
($106 at NewEgg), which is only slightly improved from the G11. 
I’m always on the lookout for new keyboards, but so far I haven’t 
found anything else to excite me. The G11 is distinguished by 18 
programmable keys, key backlighting and multimedia controls. The 
G510 is the same except the backlighting is probably better and it 
has a small multipurpose LCD screen. It’s the backlighting and pro-
grammable keys that make it worth it to me. The picture below is 
the left side, showing the key arrangement and my labels.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  You can use these 18 keys in 18 times three ways (54) because 
there are three buttons at the top of the array – M1, M2 and M3 – 
that will switch the whole bank of 18 to three sets. So far I haven’t 
found a use for switching the banks. Eighteen seems to be enough, 
so it stays on M1. Programming is pretty versatile. It accepts mac-
ros, shortcuts, functions, text and a scripting language, so I’d guess 
that you’d be hard pressed to find anything you couldn’t program. 
     The bottom three keys in the picture are pretty obvious: They’re 
a replacement for Ctl+X, C and V. I use these three constantly, 
since I’m a real believer in cut, copy and paste because I make a lot 
of mistakes and need to avoid typing as much as possible. The next 
set up is new for me, marked 1 2 3. They (and cut, copy, paste) 

don’t need labels; I marked them for this article. 1 2 3 run a little 
program I wrote in VB.NET that will pop the mouse cursor to 
the center of my monitors 1, 2 and 3 and blip some eye-catching 
circles. The only disadvantage in using three monitors is finding 
the mouse and how to get it where you want it. Problem solved: 
The buttons “Computer”, “F:”, “G:”, ”C:” and “D:” all just open 
Windows Explorer to those drive letters. “UP” moves Windows 
Explorer up one level in the directory tree, “close” closes the 
current window (it’s really Alt+F4, and a bit hazardous to use). 
“KP”, “outlook”, “IE” and “WAtracker” all launch programs and 
are used perhaps once a day. I’ll ditch any of these if I find any 
other use for the keys. “Date” runs another program I wrote to 
push the time and date into the clipboard ready for pasting. I use 
this, well,...sometimes. 
     There are several other ways to alter keyboards. I’ve disabled 
the “Caps Lock” key. It has no effect when pressed. It takes a 
complicated little registry change to do that, but just think about 
it; the only time I EVER use the Caps Lock is to switch it off 
after accidently switching it on. What a waste of keyboard space. 
Likewise “Scroll Lock.” I’ll bet not one in ten thousand keyboard 
users know what Scroll Lock is, and it’s on every keyboard wait-
ing for an accidental bump. How about the “Ins” key? Although I 
probably would not disable it as I did Caps Lock, I’d like to at 
least disable it from an accidental bump almost all the time. 
      Now that I’m started on this – let’s look at Num Lock. Ok, 
I’ll concede that some people use it. But I do own three key-
boards (two on notebooks) that have no numeric keypad. But 
Num Lock switches an array of character keys to numbers if you 
don’t have a keypad. More than once I’ve gone crazy knowing 
that I know the logon password on a computer that wouldn’t 
take. Guess what. The num lock was on, the password used char-
acters U,I,O,J,K,L or M, and being a password wouldn’t show up 
on the screen. Man, I hate that.  
     What I really want is a 100% fully programmable key-
board program built into Windows. How hard could it be?  
     There are programmable keyboards. One or two really are 
100% programmable. Even some that you just place the key 
switches wherever you want on a slate. But I don’t want it bad 
enough to pay them $1,500.  
     Pictured below: Logitech G510, NewEgg  Item#: 
N82E16823126100 for $106.00 

       Also nice in my living room 
(think NetFlix): Logitech diNovo 
Mini Black 63 Normal Keys 
Bluetooth Wireless Mini key-
board No. N82E16823126039 
for $120.00. ll 

K e y boards and Stuff 
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Online Market-
ing Inside Out 

Review: by Gregory West, Member 
of Sarnia Computer Users’ Group , 
Canada 

by Brandon Eley & Shayne Tilley 
Published by SitePoint Pty. Ltd. 
ISBN-978-0-9805768-2-5 
Pages: 184 USA: $29.95 / CDA: $29.95 
http://oreilly.com/catalog/9780980576825 
     Online Marketing Inside Out has nine 
dynamic chapters that guide you through 
your next “modern marketing campaign”. 
Chapter one explains how marketing is 
changing pointing out things you need to 
know before you begin planning your next 
promotion or campaign.  

  You will learn how to make 
money from a website by page 
views,  optimize the values within search 
engines (SEO) and how the main players in 
social media can help you go deeper inside 
the communities spreading the word of your 
company or product.  

     Even though email marketing has been 
around forever, it seems, this book sparks a 
new interest showing “many advantages” 
and the authors “walk you through every 
step towards a successful email marketing 
strategy”. 
     Having your own sales people working 
for you online is easy when you create an 
“affiliate marketing program” that is cov-

ered in Chapter 
seven. The ad-
vantages of hav-
ing an “army of 
salesmen all over 
the world” pro-
moting for you 
is explained in 
easy to under-
stand terms in 
this chapter. 
This is followed 

in sequence with Chapter eight wherein 
you learn about the world of “online adver-
tising” as you will be able to “plan, imple-
ment, test, and optimize” what you setup 
with your online advertising. 
     I really like the way this book is set out. 
The Table of Contents leaves nothing to 

imagination. The Preface wand Chapters 
have extensive headings that guide you 
through the various topics so that you 
can easily look something up and jump 
right in on that subject. For example, in 
Chapter two’s listing you will find head-
ings such as: Press Releases. Then fol-
lowed with sub-headings: Press Releases 
in the 21st Century, When to Write a 
Press Release, Stand Out From the 
Crowd and so on. 
     Every chapter tags your interest and 
keeps you coming back as a reference 
point for helping you develop your own 
online marketing campaign. This book is 
for those who “have a web site 
and...want to promote it”, or anyone else 
who wants and/or needs to learn this 
amazing subject of online marketing. 
     Even if you are already doing online 
marketing and feel fairly successful, this 
book will take you to the next level of 
expertise and guide you in directions you 
may have possibly passed by. II Take a 
look at this video…. http://gregory 
west.wordpress.com/2011/03/29/982/   

Power Friending – 
“Demystifying Social 
Media to Grow Your 
Business” 

Review: by Gregory West, Member 
of Sarnia Computer Users’ Group, 
Canada 
by Amber Mac (Amber MacArthur) 

Published by Penguin Group (USA) Inc. 
2010 
ISBN 978-1-59184-328-3 
Pages: 245, USA: $24.95 / CDA: $31.00 
http://www.ambermac.com 
     I bought this book as an aid in my re-
search into the world of social media, know-
ing that Amber MacArthur would have it all 
explained in plain English, covering all the 
bases. I was right, she did, and then some.  
     As an avid listener to Amber Mac and 
Leo Laporte via the Twit.tv network, with 
the show: Net at Night, I learned how deep 
Amber’s involvement is with technology and 
more so, social media. Her insights into this 
subject are extensive and I knew this book 
would reveal a guide that would set me on 
my exploration of social media. 
     Anyone, whether you own a business, 

operate a nonprofit group, or simply want 
to promote you own media for fun, this 
book is a guide, and Amber sets out to help 
you “build up your social media strat-
egy, one Internet friend at a time”. 

      The book con-
sists of nine 
enlightening chap-
ters starting with a 
“brief” history on 
the evolving social 
media which helps 
put thing into per-
spective and sets 
the groundwork 
for this book. Am-
ber continues on in 

this journey telling how real people and 
companies struggle though mistakes, lies, 
and failures as well as many success stories. 
From the failures we quickly learn what not 
to do in creating our own social media 
awareness. The success stories are many 
and they help to give us not only ideas but 
courage to continue through the social 
media wilderness learning a little bit more 
with each step Amber takes us. 
     Amber demonstrates three rules at the 
onset: “A IS FOR AUTHENTICITY” - 
“B IS FOR BRAVERY” - C IS FOR 
CONSISTENCY”. Each rule is explained 

with examples of how people / compa-
nies both failed and prospered by either 
following or disregarding these rules. 
     In chapter four: “CARPENTRY AT 
ITS BEST”, we are given the necessary 
social media tools to work with such as 
blogs, videos, wikis and more. Each tool 
is explained how and why it works and 
what it can do for you. Following each 
tool is a real life example how it works 
for others. I found this chapter most 
interesting and helpful. Chapter five is 
one of my favorites in which Amber 
discusses “The Strategy”. Time manage-
ment, spreading your word, responding 
and bringing the message home are a few 
topics covered. Here Amber shares her 
“Ten Best Practices...”A must read. 
     Amber points out success stories and 
failures too, all with examples so we 
don’t make the same errors. One thing I 
really am a glad about is the Notes in the 
back of the book. Here are Amber’s 
gems that refer to a topic on a certain 
page in the book with a website source 
that will take you deeper into the world 
of social media marketing. 
     I must give this book is easily a ten 
plus in not only content and information 
but Amber’s personal stories that keeps 
the material moving. II 
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Now that we’ve” conquered” the subject of 
video settings, let’s talk about file exten-
sions.   File extensions are a group of let-
ters at the end of a file name that identifies 
the type of file for the programs in your 
computer. For example, if I had a picture 
on my computer it might be named cat. 
jpg. The name of the file is cat and the ex-
tension . jpg identifies it as a picture file for 
the Windows Photo Viewer program, as 
well as other programs that I might have 
for viewing pictures. Through the magic of 
Windows, you don’t have to specify a par-
ticular program to open or view a file. In 
our example, just double clickingon cat. jpg 
will start the right program so I can see the 
picture of a cat. 
     I have a new laptop computer.  It came 
with Microsoft Word 2010 on it.   My old 
computer has Word 2003 on it. When you 
create a document with Word 2010, Word-
places a file extension of .docx on it. If you 
create a document using Word 2003 it has 
a file extension of .doc . Why? Because 
Microsoft changed something in the way it 
formats document file with Word 2010. 
Word 2010 can read .doc files created by 
Word 2003 but Word 2003 cannot read 
Word 2010 documents with a .docx file 

extension.   For people like me that use 
Word 2003 on one computer and Word 
2010 on another computer, it means that I 
can’t read documents created on the new 
computer on my old computer. Fortunately 
Microsoft has provided a solution. It lets 
me save documents created with Word 
2010 with the format used by Word 2003 
(with a .doc file extension) so I work with 
the same document on both computers. 
     Now we get to Part 2 of my problem. 
By default Windows 7, as well as other 
versions of Windows, hides file exten-
sions. This means that by just looking at 
the name of a document, I can’t tell if it 
was saved as a . doc or .docx file. In older 
versions of  Windows there was a way to 
unhide file extensions. I did that years ago 
on my old computer, it was something to 
do with “folder options” nut I no longer 
remember how I did it. It doesn’t matter. I 

want to unhide file extensions on my 
computer with Windows 7. As it turns 
o u t ,  t h i s  i s  v e r y  e a s y .

 
     Start by clicking on the Windows 7 
Start Button. In the Search Box that ap-
pears above it, type “folder options.” In 
the window that appears above the 
Search Box we’ll see “Folder Options.” 
We can also see that it is located in the 
Control Panel, but that isn’t important 
right now. Just by double-clicking on 
“Folder Options” gets us to the Folder 
Options window. This is what we want. 
If we click on the view tab (as shown in 
the illustration) we see a list of Advanced 
settings, including one that says “Hide 
extensions for known file types.” Notice 
the check mark in the box next to it.   
Click on the box to uncheck it and click 
“OK” to unhide file extensions. 
     While we’re here in the Folder Op-
tions window, notice that there are a lot 
of other options. I’ll leave it to you to 
explore them. Just remember, if you 
mess things up, just click on the “Reset 
Folders” button to restore everything to 
the default settings. II 

Discovering 
Windows 7 Part 14 
by Neil Stahfest, Vice President, Tacoma 
Area PC User Group, Washington  
     Do you have trouble seeing the text on 
your computer’s display?  New computer 
displays come in a wide range of sizes. 
Twenty years ago an 800 pixel by 600 pixel 
display was considered to be pretty high 
resolution.  

Modern LCD displays are avail-
able in a number of sizes that can 
range from 1024 by 600 pixels to 
1920 by 1080 pixels.  
By default Windows attempts to match 
your computer’s display setting to the num-
ber of pixels in the display to give you the 
sharpest image possible. Sometimes, par-
ticularly if you have a very large display, the 
text may look to small. 
     Sometimes, however, your display set-
tings may get changed. If you attach a dif-
ferent display or a projector to your com-
puter may change your settings. When you 
change back to your original display things 
may look “different” (icons in new loca-
tions and bigger or smaller, text larger or 
smaller). 
     Windows 7 makes it easy to check and 
change your display settings. Just click on 
the Windows Start button and then the 
Control Panel. Under Appearance and Per-
sonalization, click on Adjust screen resolu-
tion. This will produce a window like the 
one shown here which lets you change the 
appearance of your display. What we want 
to look at is the button next to resolution.  
As shown, when you click on it a small win-
dow with slider appears which shows you 
the range of settings available to you. 
  
            
         
       

 

 

 

 

  

      

Word 2010 
or Word 
2007 file 
type Extension 

Descrip-
tion 

Word Docu-
ment 

.docx The default 
Word file 
format. 
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Your Computer's Health  
Comprehensive Computer Maintenance Part 4   
by Greg Skalka, President, UCHUG (Under the Computer Hood 
User Group), CA 
     People need computers. Computers need maintenance. Unless 
you want to gamble with your email, continued access to the Inter-
net, your finances and the other things we have come to depend 
on from our personal computers, you should consider some pre-
ventative maintenance. Even if you are unconcerned about a tem-
porary loss of computer use, if you use it to access your financial 
accounts, you could be risking those assets and your financial 
reputation by failing to maintain your computer's resistance to 
viruses and malware. 
     Just as a car requires maintenance to provide reliable transpor-
tation, a computer needs regular care to insure it can safely and 
reliably negotiate the Information Superhighway. The concern is 
not only for making sure the computer works when you need it to 
and does not lose valuable information, but it also must protect 
you from attacks by information thieves. Neglecting basic com-
puter maintenance can increase the risk of problems resulting from 
hardware and software failures, and can leave you open to theft of 
your identity and finances. 
     Since I must provide the maintenance and IT support for all 
the computers and users in my household, I've developed a basic 
process for computer care that provides a lot of protection for 
minimal cost and effort. It has evolved over the years, as com-
puters and the threats to their well-being have changed, and has 
allowed me to prevent any serious computer problems from oc-
curring. There is nothing you can do to completely prevent prob-
lems like hard drive failures, but you can take steps that will insure 
against the loss of data and allow you to be computing again soon. 
     My computer maintenance philosophy involves three ba-
sic computer maintenance principles I call the three up's: 
setup, backup and cleanup. Setup requires that each computer 
be configured as much as possible to make maintenance easier and 
operations safer. This can involve not only your computer's hard-
ware and software, but your home network's hardware and con-
figuration as well. Backup provides a reliable way to safeguard your 
computer's data and configuration, allowing you to recover easily 
from most any problem with minimal data loss. It can not only 
prevent information loss resulting from hardware failures, but can 
also protect your computer's configuration from alteration during 
the installation of questionable software. Cleanup involves regular 
maintenance activities performed to prevent hardware problems, 
keep your software running smoothly and repel cyber attacks. Im-
plemented appropriately, these three aspects of computer mainte-
nance can keep bad things from happening to your computers and 
the information they contain. 

Setup 
A thoughtfully conceived computer setup is the foundation on 
which the other two maintenance activities are based. For best 
effect, it should be implemented on your computers when they are 
first put into service. To make the backup and cleanup operations 
easier, I always - Partition the main physical hard drive into sepa-
rate partitions for each ”Function” - Provide a second physical 
hard drive for each computer for backup storage I typically create 
7 to 8 partitions on the primary hard drive, each allocated to a 

particular function. One will contain only the operating system, 
another only data and others programs of different types. For best 
results, this must be done before any applications are installed, so 
that the OS can remain separate in its own partition.  
     These partitions can be created by Windows in most cases, but 
I prefer the versatility of a partition management program such as 
Acronis Disk Director. The OS partition is the only primary parti-
tion, with the remaining partitions consisting of logical drives in a 
secondary partition. A typical partition set for a Windows 7 com-
puter with a 1 TB hard drive might be: 
120 GB - OS (operating system and drivers only; no programs installed here 
if possible) 

50 GB - APPS1 (utility and system programs, like firewalls, anti-virus, anti-
malware and browsers) 

22 GB - GAMES (games) 

50 GB - APPS2 (office and productivity applications, including email clients 
and financial apps) 

100 GB - DATA (user data, such as documents, email, photos, source au-
dio / video files and config files) 

50 GB - APPS3 (mapping and misc. applications) 

50 GB - APPS4 (multimedia applications, like photo / audio / video editors, 
scanning and VoIP software) 

477 GB - LOCAL (scratch or working partition, for work in progress or tem-
porary backup storage) 

     I never store anything in the My Documents folder created by 
Windows, as it is on the OS partition. I instead create folders in 
each partition to help organize files and programs, so I can avoid 
having to resort to using search to find things. If a desktop com-
puter can accommodate it, I always install a second physical hard 
drive in the case for low-cost backup storage. For laptops and 
small desktops, I provide a dedicated external hard drive (eSATA 
or USB 3.0 preferred) for backup files. To protect my most sensi-
tive personal and financial files, I never store them on a computer, 
but instead keep them on a hardware-encrypted external USB hard 
drive. 
     I also configure my computer and home network for maximum 
security. All security functions available in your router should be 
enabled. I configure my network's router for strong wireless secu-
rity, and prefer to use a wired connection when possible. I don't 
allow sharing of drives or resources on my computers, but instead 
use stand-alone network drives to share files and network printers 
to share printing capabilities. Each computer runs a software fire-
wall (I like ZoneAlarm), an antivirus and several anti-malware pro-
grams. I try to keep the cabling between my computer and net-
work devices neat and labeled. It is often good to add an additional 
fan to some computers for improved cooling. I've found placing 
a laptop on a laptop cooler allows better airflow to the bottom 
and keeps it cooler (even without running the extra fans). I 
run my primary desktop computer on a low-cost UPS 
(uninterruptable power supply), so if the power goes out while 
computing, I have extra time to shut down properly and avoid data 
loss.  

Backup 
If you use computers long enough, you will have a hardware fail-
ure, the most common and devastating of which is a hard drive 
failure. To avoid the loss of my data, I make reliable backups of 
my computers as often as is reasonable. 
     Only you can decide how often your backups should be made, 
based on how much data you want to gamble with. Backing up 
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 more often puts less of your recent data at risk, but is less conven-
ient and takes time. It is easier to strike a reasonable balance be-
tween risk and time with your hard drive partitioned and segregated.  
     You can back up the more critical user data partition more often 
than the others, and with only user data in it, the backup file is cre-
ated much faster. All partitions should be backed up periodically, 
and it often helps to label the backup files you make with source 
and date in the file name, and to maintain a backup log (text file). 
     If a computer hard drive fails, I want to be able to put in a new 
drive and be running again as soon as possible, with minimal data 
loss. To do that, I make image backups of each hard drive partition, 
rather than simply copy the files. There are several backup applica-
tions that can do this; the one I prefer is Acronis True Image. I 
make my partition image backups on the second internal hard drive 
or the external hard drive, so a hard drive failure does not result in 
the loss of my backups along with the primary data. I only make my 
backups while running the bootable CD version of True Image, so 
that I am familiar with the program when tragedy strikes. If a pri-
mary hard drive fails, I can replace the drive in my computer, boot 
from the Acronis True Image CD and restore all primary drive par-
titions from the backup files on the secondary or external drive to 
the new drive. I might have lost a few of my most recent files 
(created since the last backup was made), but I can be running again 
the same day. 
     I also like to make backups of the OS and application partitions 
right before installing new programs. If I don't like a program soon 
after installing, I'll simply restore the OS and application partition 
with the last backup files made, sending my computer back in time 
to a point before the installation. I like this better than using any of 
the uninstall methods, which often leave behind files and registry 
entries to clutter my drives and slow performance.  
     It is a good idea to periodically transfer backup files to external 
drives or other removable media, in case a computer power supply 
failure takes out both internal physical drives. Transferring these 
backups to another physical location (perhaps at least once a year) 
provides cheap protection for your data should your computer be 
stolen or you lose your home from fire or other disaster. 
     For protection of my most sensitive financial files stored on a 
small external hard drive, I maintain another two identical drives as 
backups. I copy the new files to these backup drives weekly, and 
store them in a fire safe or off site. To insure adequate backups, it is 
best to develop a schedule for making each of your backup types 
and stick with it. 

Cleanup 
The final piece of the computer maintenance puzzle is cleanup. 
This involves the periodic maintenance required to insure your 
computer continues to run safely and efficiently. Just as with back-
ups, you should establish a schedule to follow to insure the proper 
maintenance is performed. Most of the required maintenance is 
done to the computer software, but there are also a few hardware 
maintenance items that should not be neglected. 
     To protect your computer from the external threats of viruses, 
spyware and other malware, the installation of good antivirus and 
anti-malware software is required. Although it seems the risk from 
viruses has diminished, running antivirus software and keeping its 
virus signatures updated is still important. Only one antivirus pro-
gram should be installed on a PC, as conflicts can result from 
multiple programs. There are many good programs to choose 

from, some of which are free. I presently use the one that comes 
with ZoneAlarm Internet Security Suite. 
     There are also plenty of choices available for anti-malware soft-
ware, with many excellent ones available for free non-commercial 
use. More is better with anti-malware software. Since they typically 
don't run in the background, many different programs can be in-
stalled and used separately without conflicts. Since some work bet-
ter on different threats than others, having a variety of anti-malware 
programs in your arsenal will provide the best detection and elimi-
nation of these threats. It is best to update your threat definitions 
and run your antivirus and anti-malware software at least once a 
week, preferably on a set schedule.  

    I run Webroot Spy Sweeper, Safer Networking Spybot -  
Search & Destroy, Lavasoft Ad-Aware, Malwarebytes  

Anti-Malware and Microsoft Windows Defender.  
     Your computer is like a living organism that starts out quick and 
vibrant, but becomes slow and develops ailments with age and use. 
The OS, applications and hard drive storage combine to form 
something like a nervous system. To detect and prevent the equiva-
lent of computer headaches, nervous breakdowns and Alzheimer, 
some basic system maintenance should be performed regularly. 
Your hard drives should be scanned for bad sectors and other drive 
errors and defragmented periodically. Operating system updates 
should be applied as they become available, to improve operation 
and close security holes. As your computer gets older and slower, 
running a registry cleaner or PC tune-up suite can clean out your 
OS and improve performance. 
     Ultimately, however, your computer may reach the point after a 
few years where “the body is willing but the mind is weak."  If your 
hardware is too good to replace but performance has been greatly 
diminished, a computer reincarnation may be appropriate. If you 
partitioned your hard drive as I described and have kept your early 
backup files, you can restore your computer's performance to its 
early days with no more effort than would be required to set up a 
new computer. 
     To give your computer a second life, simply restore your OS 
and all application (non-data) partitions, using backup files cre-
ated soon after you got the PC. Having a backup log to refer to will 
help you pick a point in time that will minimize the reinstallation of 
applications. Your data should remain on its partition unaltered.  
     After restoring, you will need to apply all OS updates since that 
backup time and reinstall applications added since, but you will 
soon be running again with a computer that feels much younger. 
You can also use this opportunity to upgrade to a larger hard drive 
with little extra effort. 
     The final cleanup item to remember is your computer hardware. 
All computers should be opened up periodically so that 
dust can be vacuumed out or blown out with canned air. 
This also applies to laptops, though you may want to avoid disas-
sembly, and only blow air into ventilation inlets and outlets. This 
will help your computer keep its cool and last much longer. 
     By following the three “ups” of computer maintenance, setup, 
backup and cleanup, you can keep your computer's performance at 
maximum with a minimum of effort, while protecting your data, 
finances and identity. By using a regular schedule of maintenance, 
little bits of time over its useful life spent taking care of your com-
puter can keep it out of intensive care. Better Ups than OOPS. II 
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Working with 
Page Numbers 
Word 2007 

by Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., 
FL  
     Adding page numbers to a document seems like a simple task. 
You open your document, position the cursor, and, on the Insert 
tab in the Header and Footer group, click Page Number. But Word 
offers several customizations for this process. It all depends on 
where you want your page numbers to appear and how you want 
them to look. 

Inserting Page Numbers 
     Your first decision is where you want to position the page num-
ber: in a header, footer, or in the margin. The most common place 
is in a footer. Fortunately, the Footer gallery has many footers 
which include page numbers. Click the Insert tab, then Footer, and 
scroll to see the gallery choices. Click a design to make it your 
footer.  
     If you find a footer you like which does not include a page num-
ber, it is possible, although not easy, to add a page number to the 
footer. To do this, insert your footer choice and double click the 
footer area to select it. You will notice that a Header and Footer 
Tools tab appears above the Ribbon whenever a header or footer is 
selected. Put your cursor in the footer where you want the page 
number to appear. Because many of these gallery footers contain 
tables, you may have to press Ctrl+tab to set a tab stop within the 
table cell in order to put your cursor exactly where you want it.  
     Once the cursor is set, under Header and Footer tools, click 
Page Number. Click "Current position" which opens the Number 
Style gallery. Click a design for your number from the gallery, and it 
will appear in the footer. Warning: If you choose an option other 

than "Current position," such as 
"Bottom of the page," the page number 
will replace the footer instead of adding 
to it.  
     An easier approach is to insert the 
page number first, and then add other 

elements and information to your footer. To do this, on the Insert 
tab, in the Header and Footer group, click Page Number. Choose 
"Bottom of the page," then click a number style from the list, mak-
ing sure the design puts the page number in the area of the footer 
where you want it to appear (left, center or right). To insert content 
after the page number in the footer, press the End key, then the 
Tab key. Then enter the content, such as author's name or date. 
You may need to use the Tab key to adjust the position of content 
items. 

Formatting Page Numbers 
     Office 2007 is full of new galleries, which are collections of pre-
formatted content which can be added to a document with a single 
click. To see the page number gallery of styles, start with a docu-
ment that does not contain page numbers. On the Insert tab, click 
Page Number and then one of positions, such as "Top of the Page." 
A gallery opens that shows page numbers in various positions on 
the page. Some include graphical elements, others text, such as 

"Page X of Y," as in Page 3 of 14. More options can be found in 
the Building Blocks Organizer. Click the Insert tab -- Quick Parts -- 
Building Blocks Organizer and scroll to the Page Number gallery. 
     To change the actual number type, such as from numeric to 
Roman numerals, click the Page Number icon and select "Format 
Page Numbers." Choose the style you want from the drop down 
list. 
     Of course, you can always select just the page number and for-
mat it yourself. Double click in the area where you've put the num-
ber, then select the page number to reveal a mini-toolbar just above 
it. Here you can easily change the font and apply attributes such as 
color, boldface, or italics. To change the size of the number using 
the mini-toolbar, either click the large or small capital A icon, which 
grows or shrinks the selected number, or change the font size num-
ber. The new format is copied immediately to all other page num-
bers in the document. 

Removing Page Numbers 
     The easiest way to remove all page numbers in a document is to 
select one of them and press the Delete key. If you have created a 
footer which includes a page number and other content, the con-
tent will remain even if the page number is deleted.  

Managing Page Numbers 
     Often you will not want a page number to appear on the first 
page, which might be a cover sheet or title page. It isn't difficult to 
remove the page number from the first page, but don't just delete 
the number 1. This will cause all the other page numbers to disap-
pear as well. Instead, remove the first page number using the 
"Different first page" command. Let's say you have added a footer 
which contains the author's name and the page number. Double 
click in the footer area of the first page, which opens the Header 
and Footer Tools tab. Click to put a checkmark next to "Different 
first page" in the Options group. Your footer and page number will 
be removed from the first page. The second page will contain the 
footer and page number 2. You can now insert a footer that does 
not include a page number on the first page, if you wish, without 
changing the numbering on the rest of the pages. 
     If you want the first page to be unnumbered, but the second 
page to display page number 1, insert a footer with page numbers in 

the document, then double 
click in the footer area of the 
first page. Under Header and 
Foote r  Too l s ,  s e l ec t 
"Different First Page." Then 
click Page Number -- Format 
Page Numbers. In the "Start 
at" box, type 0, and then click 
OK. 
     It is also possible to 
change the numbering style 
or format in different sec-
tions or chapters of a book 
or long document. A section 

within a long document can, for instance, include no page numbers, 
even though the surrounding sections are numbered. 
     Working with page numbers is just one example of the depth of 
options available within Microsoft Office programs. The more you 
become familiar with the options and how to use them, the closer 
you will come to fully utilizing these programs. II 
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